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Глава  2
ОСНОВЫ АНИМАЦИИ

§ 6. Основные понятия. Редактор для создания анимации

Самый ранний образец анимации 
создан примерно 5000 лет назад. Он 
представлен на кубке из необожжен-
ной глины, обнаруженном во время 
раскопок в Иране. На кубке изобра-
жена коза, которая подпрыгивает и 
срывает листья с пальмового дерева.

Каждое отдельное изображение 
козы на кубке представляет собой 
отдельный кадр.

В 1877 г. было запатентовано изоб-
ретение француза Шарля-Эмиля 
Рейно  (1844—1918) — праксиноскоп.

Шарль-Эмиль 
Рейно

Праксиноскоп

Праксиноскоп представлял со-
бой устройство из открытого цилин-
дра, в центре которого находилась 
зеркальная призма. Число граней 
призмы соответствовало количеству 
изображений-миниатюр. При бы-
стром вращении цилиндра на види-
мой грани призмы создавалась ил-
люзия движения.

6.1. Анимация. Виды анимации

Человек с древности пытался запе-
чатлеть движение в рисунке. Сегодня 
движение изображений можно видеть 
в мультфильмах, в видеофильмах, в 
рекламных баннерах на веб-страницах 
и др. А слово анимация известно даже 
маленьким детям. 

Анимация (от лат. animare — 
оживить) — процесс изменения раз-
мера, положения, цвета или формы 
объекта с течением времени.

Анимация представляет собой по-
следовательную демонстрацию серии 
изображений (кадров). Кадр отобража-
ется некоторое время, после чего исче-
зает, а на его месте появляется новый.
Кадры — изображения последова-

тельных фаз движения объектов или 
их частей.

Анимация основана на свойстве че-
ловеческого зрения «помнить» изобра-
жение в течение некоторого времени, 
после того как наблюдение прекра-
щается. Чем больше кадров содержит 
анимация, тем более сглаженным будет 
движение в процессе ее проигрывания. 
Для создания иллюзии непрерывного 
движения частота смены кадров долж-
на быть не менее 12 кадров в секунду.

Первоначально, при подготовке кад-
ров для анимации, каждый кадр рисо-
вался отдельно и полностью, что отни-
мало много времени даже у большого 
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коллектива художников. Затем стала 
использоваться послойная техника ри-
сования объектов и фонов на прозрач-
ных пленках, накладываемых друг на 
друга. Это снизило трудоемкость работ, 
т. к. не нужно было рисовать каждый 
кадр полностью. Современные анима-
ционные технологии переведены на 
компьютерную основу.

Компьютерная анимация — соз-
дание анимации с помощью компью-
тера.

Работая над созданием компьютер-
ной анимации, художник обычно про-
рисовывает начальное и конечное по-
ложение движущихся объектов, а все 
промежуточные состояния рассчитыва-
ет и изображает компьютер. Объекты 
компьютерной анимации размещаются 
на разных слоях (подобно прозрачным 
пленкам в классической анимации).

При создании компьютерной анима-
ции могут использоваться растровые 
изображения (Gif-анимация) и вектор-
ные рисунки (Flash-анимация).

Выделяют два способа создания 
компьютерной анимации: 

  покадровая анимация;
  расчетная анимация — анимация 

движения объектов и анимация формы.
При создании покадровой анима-

ции прорисовываются все фазы движе-
ния объекта. Такая технология незаме-
нима при создании сложной анимации 
с разнообразной графикой.
Анимация движения или формы 

предполагает рисование только от-
дельных кадров. В этих кадрах объект 
располагается в начале и в конце дви-

Уолт Дисней Н. Н. Константинов

Послойную технику в мультиплика-
ции впервые применил Уолт Дисней 
(1901—1966) — американский худож-
ник-мультипликатор, основатель ком-
пании Walt Disney Productions.

В 1968 г. группа советских уче-
ных во главе с Николаем  Нико-
лаевичем  Константиновым (со-
ветским и российским математиком, 
род. в 1932 г.) создала математиче-
скую модель движения животного. 
Вычислительная машина БЭСМ-4, 
выполняя программу, прорисовыва-
ла кадры мультфильма с анимацией 
движений кошки. Для создания ки-
нопленки с мультфильмом каждый 
кадр был распечатан на принтере, 
роль пикселя играла буква «Ш».

В настоящее время существуют 
различные технологии создания ком-
пьютерной анимации. Например:

  Запись движения. Актеры в спе-
циальных костюмах с датчиками 
совершают движения, которые за-
писываются камерами и анализи-
руются специальным программным 
обеспечением. Итоговые данные о 
перемещении суставов и конечностей 
актеров применяют к трехмерным 
скелетам виртуальных персонажей, 
благодаря чему добиваются высокого 
уровня достоверности их движения.

  Процедурная анимация полно-
стью или частично рассчитывается 
компьютером.

  При программируемой анима-
ции движения объектов программи-
руются с помощью браузерного язы-
ка JavaScript и языка работы с Flash-
приложениями ActionScript.
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жения. Все остальные кадры — проме-
жуточные. Изображение в них создает 
компьютерная программа, которая вы-
числяет, где и в какой момент должен 
находиться объект. Расчетная анима-
ция используется для создания анима-
ционных эффектов на веб-страницах, а 
также при создании рекламных, учеб-
ных и развлекательных фильмов.

6.2. Редактор Flash

Появлению компьютерной анима-
ции способствовало развитие программ 
для работы с графикой.

Программы для работы с анимацией 
представлены в примере 6.1. Одним из 
наиболее популярных редакторов для 
создания анимации является Flash. 
Преимущество Flash в том, что с его 
помощью можно создать красивую ани-
мацию, а файлы будут небольшого раз-
мера. Редактор Flash имеет интерфейс, 
многие элементы которого знакомы 
вам по опыту работы в графических 
редакторах (см. Приложение 2, с. 156).

В начале работы в редакторе необхо-
димо создать новый документ (File → 
→ New...) либо открыть уже существу-
ющий (File → Open...). 

Документ, созданный в Flash, приня-
то называть фильмом. В окне редактора 
Flash можно одновременно открывать 
несколько файлов с фильмами. Вклад-
ки открытых файлов располагаются 
под строкой меню: .

Для перехода к нужному файлу до-
статочно щелкнуть мышью по вкладке 
с его именем. Звездочка справа от име-
ни файла обозначает, что в нем сдела-
ны изменения, которые не сохранены.

Пример 6.1. Для создания аними-
рованных изображений существует 
множество программ, как платных, 
так и бесплатных. Например:

Vectorian Giotto

Adobe Animate

Easy GIF Animator

Pivot Stickfigure 
Animator

История Flash началась в 1996 г., 
когда компания Macromedia выпу-
стила продукт под названием Flash. 

В 2005 г. вышла версия Macromedia 
Flash Professional 8. В этой версии 
улучшена работа с графикой и ани-
мацией. В том же году фирма Adobe 
купила Macromedia вместе с ее про-
дуктами, включая Flash.

Значки различных версий редак-
тора Flash:

Macromedia Flash 
MX 2002

Macromedia Flash 
Professional 8 2005

Adobe Flash 
Professional CC 2015

Для устройств, которые не под-
держивают Flash, можно сохранить 
фильм в форматах HTML и GIF. В 
этом случае мультипликация может 
быть воспроизведена практически на 
всех устройствах.

Редактор Flash поддерживает язык 
сценариев (описания поведения объ-
екта) ActionScript. Используя этот 
язык, можно создавать интерактив-
ные (содержащие элементы взаимо-
действия с пользователем) фильмы.
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В левой части окна редактора Flash 
располагается Панель инструментов, 
состоящая из четырех разделов:

  Инструменты (Tools) — инструмен-
ты рисования и редактирования; 

  Просмотр (View) — способ просмо-
тра;

  Цвета (Colors) — цвета обводки и 
заливки;

  Параметры (Options) — настройка 
свойств выбранного инструмента.

(Рассмотрите пример 6.2.)
В рабочей области редактора Flash 

можно выполнять операции создания 
и редактирования объектов (см. Прило-
жение 2, с. 156). В кадр попадают толь-
ко те объекты, которые расположены в 
пределах монтажного стола. Осталь-
ная часть рабочей области нужна для 
предварительных рисунков и для реа-
лизации эффекта постепенного входа 
объекта в кадр (или выхода из кадра).

Размеры монтажного стола можно 
изменить (пример 6.3) в окне Свойства 
документа (Document Properties). 

Над рабочей областью находится 
шкала времени и список слоев (при-
мер 6.4). Шкала времени (Timeline) 
предназначена для работы с кадрами. 
Слои (Layers) — компьютерный аналог 
прозрачных пленок, которые применя-
ются в традиционной мультипликации.

В правой части окна размещаются 
дополнительные панели (пример 6.5).

Редактор Flash поддерживает век-
торную графику, однако позволяет ис-
пользовать и растровые изображения, 
импортированные из внешних файлов. 
При сохранении фильма в редакторе 
Flash обычно используют два типа фай-
лов: .fla и .swf. Собственным форматом 

Пример 6.2. Разделы Панели ин-
струментов редактора Flash.

Пример 6.3. Изменение размеров 
монтажного стола.

Пример 6.4. 

Шкала времени

Список слоев
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Flash является формат FLA. В этом 
формате фильм сохраняется для после-
дующего редактирования. Для реализа-
ции возможности просмотра фильма его 
нужно опубликовать.
Публикация — сохранение фильма 

в формате SWF. Опубликовать файл 
можно, выполнив команду Файл → 
→ Опубликовать (File → Publish) или 
с помощью комбинации клавиш Ctrl + 
+ Enter. Файл при публикации сохра-
няется в папку, в которой находится 
файл формата FLA. Опубликованный 
фильм можно просмотреть в любом про-
игрывателе Flash, а также в браузере.

Редактор Flash позволяет экспор-
тировать результаты работы в другие 
форматы. Для этого необходимо выпол-
нить команду Файл → Экспорт → Экс-
порт фильма (File → Export → Export 
Movie) и выбрать формат файла (при-
мер 6.6).

Пример  6.5.  Дополнительные 
панели.

1.  Что называют анимацией?
2.  Что представляет собой кадр?
3.  С какой минимальной частотой должна происходить смена кадров, чтобы соз-
давалась иллюзия непрерывного движения?
4.  В чем заключается покадровая анимация?
5.  Чем расчетная анимация отличается от покадровой?
6.  В каком формате нужно сохранить фильм, чтобы его можно было редактировать?
7.  Что значит опубликовать фильм?

Упражнения

   Откройте редактор Flash. Создайте новый документ. Используя материал § 6 
и Приложения 2 (с. 156), изучите интерфейс окна редактора. Выполните:

1. В меню выберите Вид → Сетка → Показать сетку (View → Grid →
→ Show Grid). Как изменилась страница в Рабочей области?
2. Установите размеры монтажного стола .

3. Изучите инструменты раздела Просмотр (View) на Панели инстру-
ментов. С помощью инструмента Рука (Hand Tool) ( ) переместите 
страницу в Рабочей области. Увеличьте видимый размер страницы и 

?

Пример 6.6. Экспорт файлов.

Смеситель цветов 
(Color Mixer)

Библиотека 
(Library)
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уменьшите его с помощью инструмента  Лупа (Zoom Tool). Настрой-

те увеличение (уменьшение) масштаба в разделе Параметры ( ).
4.  Откройте (закройте) дополнительные окна Смеситель Цветов и Би-
блиотека.

   Откройте в редакторе Flash файл. Сохраните файл под новым именем. Выполни-
те публикацию фильма. Просмотрите фильм в проигрывателе Flash.

§ 7. Создание изображений и редактирование объектов

Пример 7.1. Рисование линий.

        
Перед рисованием линии на Пане-

ли свойств выбрать:

1.  Толщину: 
2.  Цвет: 

7.1. Создание изображений

Основным анимируемым объектом 
редактора Flash является векторное 
изображение. Создание векторных изоб-
ражений в Flash имеет много общего с 
аналогичным процессом в векторных 
редакторах. Рассмотрим особенности 
использования инструментов рисова-
ния редактора Flash.

Для рисования линий в редакто-
ре Flash используется инструмент  
Линия (Line). Определить цвет, стиль 
и толщину можно на Панели свойств 

(пример 7.1). Линии с углом наклона, 

кратным 45°, рисуются при нажатой 
клавише Shift. 

Овал можно нарисовать с помощью 
инструмента  Овал (Oval). Этот ин-
струмент также используется для рисо-
вания круга и окружности (при нажа-
той клавише Shift).

Для рисования прямоугольников ис-

пользуют инструмент  Прямоуголь-
ник (Rectangle). Чтобы задать радиус 
закругления углов прямоугольника, 
нужно на Панели инструментов в раз-
деле Параметры выбрать  и в диа-
логовом окне Настройки прямоуголь-
ника (Rectangle Settings) ввести зна-
чение радиуса в пикселях (пример 7.2).

3.  Стиль:

Пример 7.2. Рисование прямо-
угольника с закругленными углами.

Пример 7.3. Диалоговое окно Tool 
Settings.
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Для рисования многоугольников и 
звезд нужно выбрать инструмент  
Многоугольник/Звезда (PolyStar), раз-
вернув список инструмента :

Когда инструмент  активен, на 
Панели свойств находится кнопка 

, которая вызывает окно на-
стройки инструмента (пример 7.3). В нем 
можно выбрать тип фигуры (много-
угольник/звезда), задать количество сто-
рон (лучей) и их размер (пример 7.4).

Для рисования линий и кривых ис-
пользуется инструмент  Перо (Pen) 
(пример 7.5). С помощью этого инстру-
мента легко рисовать ломаную линию. 
Щелчками мыши рисуется отрезок 
или контур, состоящий из отрезков 
прямых линий, соединенных угловы-
ми (опорными) точками.

Для рисования контуров произволь-
ной формы используется инструмент 

 Карандаш (Pencil). Для инструмен-
та Карандаш можно выбрать различ-
ные режимы рисования (пример 7.6):

  Выпрямление (Straighten) позво-
ляет преобразовать исходное изобра-
жение в одну из геометрических фигур 
(пример 7.7);

  Сглаживание (Smooth) сглажива-
ет линии. Степень сглаживания линий 
задается на Панели свойств в поле 

;

  Рисунок чернилами (Ink) похож на 
режим Smooth. Степень сглаживания 
незначительна и не изменяется.

Пример 7.4. Рисование много-
угольников и звезд.

Пример 7.5. Рисование ломаной 
линии инструментом Перо.

Пример 7.6. Выбор режима рисо-
вания для инструмента Карандаш.

Пример 7.7. Использование ин-
струмента Карандаш в режиме Вы-
прямление.

Во время 
рисования

После завершения 
рисования
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 7.2. Редактирование изображений

При подготовке кадров анимации 
приходится редактировать существую-
щие объекты. Свойства обводки и за-
ливки (цвет, форма, взаимное располо-
жение) могут изменяться пользователем 
независимо друг от друга. Заливку и 
обводку можно удалять по отдельности.

Прежде чем выполнить какие-либо 
действия с объектом, его необходимо 
выделить. Редактор Flash обладает 
большим спектром инструментов вы-
деления (пример 7.8). Основной ин-
струмент выделения —  Выбор 
(Selection). С его помощью можно выде-
лить весь объект, заключив его в прямо-
угольник. Тот же результат получит-
ся, если выполнить двойной щелчок 
по объекту. Несколько объектов выде-
ляются при нажатой клавише Shift. 
Выделенный объект покрывается мел-
кой сеткой. Щелчком можно выделять 
заливку или обводку по отдельности 
(пример 7.9).

С помощью инструмента  можно 
выполнять следующие операции ре-
дактирования объектов:

  Перемещение. Выделить объект. 
При появлении крестика из двунаправ-
ленных стрелок переместить объект.

  Изменение положения вершин. 
Подвести курсор к вершине и переме-
стить вершину.

  Изменение контура. Не выделяя 
контур, подвести курсор к контуру и 
переместить в нужном направлении.

(Рассмотрите пример 7.10.)
Многие операции изменения объек-

тов могут быть выполнены с помощью 
инструмента  Произвольная транс-

Пример 7.8. Инструменты выде-
ления:

 — Выбор (Selection);

 — Выбор подобласти 
(Subselection);

 — Петля (Lasso); 

 — Произвольная трансформа-
ция (Free Transform);

 — Перо (Pen Tool).

Пример 7.9. Выделение объектов.

Весь объект Заливка

Часть обводки
Все части 

обводки (с Shift)

Пример 7.10. Использование ин-
струмента .

                 
Перемещение

Изменение положения вершин

Изменение контура
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формация (Free Transform). При ра-
боте с инструментом  после выделе-
ния объекта на Панели инструментов 
становятся доступными кнопки выбора 
режимов: 

  Поворот и наклон (Rotate and 
Skew);

  Масштабирование (Scale);
  Искажение (Distort);
  Изгиб (Envelope).

(Рассмотрите пример 7.11.)
Пример 7.12 иллюстрирует измене-

ние объекта при использовании инстру-
мента Произвольная трансформация в 
разных режимах. Трансформация вы-
полняется с помощью маркеров, рас-
положенных на выделяющей рамке. 
Каждый маркер связан с определенной 
операцией. Разным маркерам соответ-
ствует свой вариант указателя мыши.

С помощью команд меню Изменить 
(Modify) можно выполнить операции 
над объектами:

  Преобразование (изменение разме-
ра, поворот, отражение и др.) — Транс-
формация (Transform);

  Группировку (объединение не-
скольких объектов в один) — Группи-
ровка (Group);

  Выравнивание (по горизонтали и 
по вертикали, относительно границ 
объектов и относительно центра) — 
Выравнивание  (Align).

Пример 7.11. Кнопки выбора ре-
жима для инструмента Произволь-
ная трансформация.

Исходное изображение

                 
                         Поворот                                Наклон    

                                             
Масштабирование                     Искажение

Изгиб

Пример 7.12. Использование ин-
струмента Произвольная трансфор-
мация.

Options

1.  Какие инструменты редактора Flash используются для рисования?
2.  В каком режиме инструмента Карандаш рисуются геометрические фигуры?
3.  Для чего предназначен инструмент Выбор?
4.  Какие преобразования объекта можно выполнить с помощью инструмента 
Произвольная трансформация?

?
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      Упражнения

   Откройте файл. Дополните изображение автомобиля. При 
рисовании окна используйте градиентную заливку. Скопируй-
те изображение окна, примените к копии операцию отраже-
ния. Сохраните изменения в файле.

   Создайте изображения, воспользовавшись рекомендациями.

Изображения Рекомендации

Используйте инструменты  и с настройками:

Примените инструмент  для преобразования линий 
в дуги либо нарисуйте дуги как часть окружности.

Для рисования используйте инструменты  и . Ин-
струмент  применяйте в различных режимах. Кор-
ректируйте изображение с помощью инструмента .

Копирование окон выполняйте, удерживая клавишу 
Shift.
Для изгиба дома используйте инструмент .
Скорректируйте контур с помощью инструмента .

Сохраните изображения в формате FLA.

   Нарисуйте одного из роботов. Для рисования используйте инструменты , , 

 и инструмент редактирования . Сохраните изображение с именем, соответ-
ствующим эмоции робота.
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§ 8. Слои. Библиотека объектов. Импорт объектов

Пример 8.1. Применение слоев.

Пример 8.2. Создание нового слоя.

Пример 8.3. Создание папки слоев.

8.1. Работа со слоями

Слои — важнейший элемент анима-
ции. Применение слоев позволяет соз-
давать сложные многоплановые сцены 
фильма, редактируя каждый объект 
на отдельном слое. Один из слоев мо-
жет использоваться в качестве фо-
на, другой содержать анимированные 
объекты, а третий — элементы зву-
кового сопровождения фильма (при-
мер 8.1).

Имена слоев показаны слева от вре-
менной шкалы. После создания файла 
в списке слоев находится один слой с 
именем Layer 1 (Слой 1). 

Для создания нового слоя требует-
ся выделить тот слой, над которым вы 
хотите поместить новый, а затем на-
жать кнопку  Вставить слой (Insert 
Layer). Новый слой появляется в спи-
ске слоев над выделенным слоем, как 
видно из примера 8.2. 

Новому слою присваивается имя 
Layer с указанием порядкового номера. 
Это имя обычно заменяют именем, по-
ясняющим назначение или содержание 
слоя.

Для удобства работы со слоями в 
Flash реализована возможность хране-
ния каждого набора взаимосвязанных 
слоев в отдельной папке слоев (при-
мер 8.3).

Все слои абсолютно прозрачны. Объ-
екты, расположенные на различных 
слоях, визуально воспринимаются как 
элементы единой сцены. Объект, на-
ходящийся на верхнем слое, заслоняет 

Правообладатель Народная асвета



38 Глава 2. Основы анимации

объекты, находящиеся в той же пози-
ции на нижних слоях (пример 8.4).

Можно изменять порядок располо-
жения слоев. Объекты одного слоя 
редактируются независимо от объек-
тов других слоев. При необходимости 
можно одновременно выбрать объекты 
из разных слоев и работать с ними как 
с единым целым. Например, изменить 
их цвет.

Удалить слой (папку) можно щелчком 
по кнопке  Удалить слой (Delete 
Layer), расположенной в нижнем правом 
углу Панели управления слоями. При 
удалении папки удаляются также и 
входящие в нее слои.

Значки справа от имени слоя отоб-
ражают его свойства:

  Активность. В этом слое объ-
екты создают или редактируют. Слой 
выделяется в списке цветом и поме-
чается значком .

  Видимость. Объекты скрытого 
слоя не видны, слой помечается .

  Блокировка. Слой помечается в 
списке значком .

(Рассмотрите пример 8.5.)
На заблокированном или скрытом 

слое нельзя радактировать и создавать 
объекты. При создании анимации для 
нередактируемых слоев устанавлива-
ется блокировка и отключается види-
мость.

8.2. Библиотека объектов

При создании анимации возникает 
необходимость использовать некоторые 
объекты несколько раз. Для хране-
ния таких объектов в редакторе Flash 
предназначена Библиотека (Library). 

Пример 8.4. Отображение слоев 
в зависимости от их расположения.

Пример 8.5. Отображение слоев 
с различными свойствами.

Правообладатель Народная асвета



39§ 8. Слои. Библиотека объектов. Импорт объектов

Объекты, помещенные в библиотеку, 
называют символами. Использование 
символов существенно ускоряет про-
цесс разработки фильма.

Один раз созданное изображение 
можно многократно использовать как 
в одном, так и в разных фильмах. 

Существуют три типа символов:
1.  Графика (Graphic). Содержит изо-

бражение одного кадра.
2.  Кнопка (Button). Содержит кноп-

ки, реагирующие на действия пользо-
вателя и управляющие воспроизведе-
нием фильма. 

3.  Клип (MovieСlip). Может содер-
жать анимацию с любым количеством 
кадров.

Для преобразования объекта в сим-
вол нужно нажать клавишу F8 или пе-
ретащить изображение в окно Библио-
тека. Затем в области просмотра верх-
ней части панели Библиотека можно 
увидеть изображение символа, а в 
списке символов — имя символа (при-
мер 8.6).

Копию символа, помещенную в рабо-
чую область, называют экземпляром. 
Экземпляры могут значительно отли-
чаться от самого символа. При редак-
тировании экземпляра символ не изме-
няется. И напротив, любые изменения 
символа приводят к соответствующим 
изменениям всех его экземпляров. 

Каждый экземпляр имеет собствен-
ные свойства, которые могут редакти-
роваться без изменения соответствую-
щих свойств символа. Так, можно изме-
нять цвет и прозрачность экземпляра, 
переопределять его тип (например, 
преобразовать графический символ 

Пример 8.6. Создание символа 

типа Графика.

1.  Перетащить выделенное изо-

бражение в список символов панели 

Библиотека:

2.  В окне Convert to Symbol вы-

брать тип Graphic и дать имя символу:

3.  Просмотреть содержимое библио-

теки:
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в кнопку). Можно также наклонять, 
вращать или масштабировать экземп-
ляр без того, чтобы воздействовать на 
символ.

При выделении экземпляра вокруг 
него появляется голубая рамка (при-
мер 8.7). 

Редактирование символа осущест-
вляется в специальном режиме, перей-
ти в который можно с помощью двой-
ного щелчка по изображению символа 
на панели Библиотека. Для выхода 
из этого режима необходимо нажать 
кнопку , расположенную над спи-
ском слоев (пример 8.8).

Для редактирования свойств эк-
земпляра используются инструменты 
трансформации и инструменты Панели 
свойств (Properties) (пример 8.9).

Преобразовать экземпляр символа в 
обычную векторную графику можно, 
выбрав команду Break Apart из кон-
текстного меню экземпляра или нажав 
комбинацию клавиш Ctrl + B.

8.3. Импорт и использование 
объектов

Редактор Flash поддерживает мно-
гие форматы для импорта изображе-
ний — JPEG, GIF, PNG и PSD.

Существуют следующие варианты 
импорта изображений (меню Файл → 
→ Импорт):

  непосредственно в рабочую область 
(Import to Stage);

  в библиотеку (Import to Library).
Импортированные в библиотеку изо-

бражения представляют собой символы.

Пример 8.7. Создание экземпляров 
символа.

Перетащить изображение символа 
с панели Библиотека на холст.

Пример 8.8. Редактирование сим-
вола.

Пример 8.9. Редактирование эк-
земпляра.

1.  С помощью инструментов транс-
формации.

2.  Изменение цвета на панели 
Properties.
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Для импортирования изображений с 
прозрачностью фона рекомендуется ис-
пользовать формат PNG (пример 8.10).

Импортированные растровые изобра-
жения преобразуются в векторные для 
последующего редактирования с по-
мощью команды Изменить (Modify) → 
→ Bitmap → Trace Bitmap (пример 8.11).

Размер импортированных изображе-
ний может не соответствовать разме-
ру монтажного стола. Для устранения 
этого несоответствия изменяют либо 
размер монтажного стола, либо размер 
изображения.

Выбор команды Открыть внешнюю 
библиотеку (Open External Library) ме-
ню Файл (File) → Import (Импорт) по-
зволяет открывать библиотеку любого 
файла Flash (формата .fla) и использо-
вать ее символы.

Пример 8.10. Импорт изображе-
ний разных форматов.

Пример 8.11. Редактирование век-
торного изображения, преобразован-
ного из растрового.

1.  С какой целью используют слои?
2.  Для чего предназначена библиотека объектов?
3.  Что представляет собой символ?
4.  Как преобразовать объект в символ?
5.  Что такое экземпляр символа?
6.  Как перейти в режим редактирования символа?
7.  Куда можно импортировать изображения в редакторе Flash?

Упражнения

   Откройте файл и выполните задания.

1.  Измените порядок следования 
слоев (слой «дом» перетащите 
вверх). Уберите видимость слоя 
«дом».
2.  Между слоями «дом» и «фон» 
создайте слой «облака». Нарисуйте 
в этом слое облако и преобразуйте 
в символ. Разместите несколько 
экземпляров символа «облако» на 

?
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слое. Преобразуйте экземпляры (размер, поворот, наклон, цвет). Открой-
те видимость слоя «дом».

                                     

3. Создайте в списке слоев папку «задний 
план» и перетащите в нее слои «фон» и «об-
лака». Установите блокировку папки.
4. Активизируйте слой «дом», снимите его 
блокировку. Поместите на слой из библиоте-
ки несколько экземпляров символа «окно». Измените цвет окон, исполь-
зуя возможности панели Properties.
5. Сохраните результат работы в файл с именем upr8_2.fla.

   В редакторе Flash откройте одновременно файл upr8_2.fla и файл с изобра-
жением автомобиля, полученный в результате выполнения упражнения 1 после § 7. 
Выполните перечисленные действия:

1. Создайте символ изображения автомобиля на новом слое.
2. Возвратитесь в файл upr8_2.fla и, выбрав библиотеку файла с авто-
мобилем, создайте экземпляр автомобиля. Измените цвет экземпляра.

3. Сохраните изменения в файле.
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   В файле upr8_2.fla добавьте новые слои с изображениями и преобразуйте их в 
символы:

Пример 9.1. Отображение кадров 
на шкале времени.

Пример 9.2. Отображение кадров 
на шкале времени.

Ключевой кадр с содержи-
мым (редактируется, являет-
ся исходным)

Ключевой кадр без содержи-
мого

Простые кадры (продлевают 
видимость предшествующего 
ключевого кадра)

Промежуточные кадры (ото-
бражают трансформацию объ-
екта между двумя ключевы-
ми кадрами)

Основным инструментом при соз-
дании анимации является шкала 
времени. С ее помощью можно вы-
полнять различные операции с кад-
рами.

На шкале времени каждому слою 
соответствует строка с сеткой. Каждой 
ячейке соответствует отдельный кадр. 
Числа над шкалой обозначают номера 
кадров. На кадр, находящийся на мон-
тажном столе, указывает маркер кад-
ра — красный прямоугольник с лини-
ей (пример 9.1).

Кадры, содержимое которых опреде-
ляется автором анимации, называются 
ключевыми. 

Отображение кадров на шкале вре-
мени зависит от их предназначения.

(Рассмотрите пример 9.2.) 
При выполнении операций с кадра-

ми можно использовать команды кон-
текстного меню кадра, а также «горя-
чие» клавиши:

Дополните изображение в upr8_2.fla 
экземплярами символов. Измените символы 
в соответствии с рисунком. Сохраните изме-
нения в файле.

§ 9. Покадровая анимация
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  Insert Keyframe , F6 — вставка копии 
ключевого кадра;

  Insert Blank Keyframe , F7 — вставка пусто-
го ключевого кадра;

  Insert Frame , F5 — вставка простого 
кадра;

  Clear Keyframe , Shift + F6 — очистка 
ключевого кадра;

  Remove Frames , Shift + F5 — удаление 
кадра.

Перед вставкой кадра необходимо 
предварительно выделить ячейку сет-
ки, предназначенную для размещения 
нового кадра (пример 9.3). Операции 
выделения группы кадров выполняют-
ся так же, как и операции выделения 
группы других объектов.

Для изменения положения кадра в 
шкале времени достаточно перетащить 
его в требуемую позицию.

Анимация, полностью состоящая из 
ключевых кадров, называется пока-
дровой анимацией.

При создании покадровой анимации 
для каждого ключевого кадра устанав-
ливается длительность проигрывания.

Чем больше кадров в покадровой 
анимации, тем естественнее движения 
персонажей. Чтобы движения объектов 
в анимации не были резкими, а фильм 
слишком коротким или быстрым, 
можно добавить:

  ключевые кадры с промежуточным 
положением анимируемого объекта;

  простые кадры после каждого клю-
чевого кадра.

Для добавления к анимации фона 
нужно создать еще один слой. При соз-
дании нового слоя сразу создается пу-
стой ключевой кадр и простые кадры 

Пример 9.3. Вставка ключевого 
кадра.

1.  Выделить ячейку сетки.

2.  Нажать F6.

Пример 9.4. Создание фонового 
слоя.

При создании покадровой анима-
ции рекомендуется придерживаться 
следующих правил:

1.  Выполняя сжатие и растяже-
ние, сохраняйте объем (удлиняя объ-
ект, не забывайте сужать его).

2.  Объект не должен слишком рез-
ко останавливаться и замирать — 
количество кадров должно быть та-
ким, чтобы движение объекта было 
плавным.

3.  Медленный выход и медленный 
вход.

4.  Верный расчет времени — важ-
но задать достаточно времени, чтобы 
подготовить зрителя к ожиданию 
действия, самому действию и реак-
ции на действие.

Обычно на монтажном столе на-
ходится один кадр. Чтобы упростить 
размещение и редактирование пока-
дровой анимации, можно просматри-
вать на монтажном столе два и не-
сколько кадров одновременно. Такой 
режим называется режимом кальки-
рования.
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по длине уже готовой анимации. Одно-
го ключевого кадра достаточно, т.  к. 
фон статичен (пример 9.4).

Перед публикацией анимацию нуж-
но протестировать — выбрать в меню 
редактора команду Контроль → Те-
стирование фильма (Control → Test 
Movie).

В примере 9.5 показан процесс соз-
дания покадровой анимации.

Преимуществом покадровой анима-
ции является ее естественность, по-
скольку каждый следующий кадр не 
похож на предыдущий.

Недостатки покадровой анимации:
  при необходимости изменения всей 

анимации нужно изменять каждый 
кадр;

  занимает большой объем, т. к. при-
ходится хранить информацию о каж-
дом кадре.

В Flash есть инструменты для кальки-
рования анимации. Например, функция 
Луковая шелуха (Onion Skin), позволя-
ющая аниматору просматривать любое 
количество последовательных кадров.

После выбора режима калькирова-
ния содержимое выделенного в данный 
момент кадра отображается в полном 
цвете, а содержимое соседних кадров 
отображается в виде полупрозрачного 
шлейфа.

Пример 9.5. Создание покадровой 
анимации.

1.  Открыть файл с изобра-
жением лучей солнца.

2.  Создать копию кадра.

3.  Изменить второй кадр, допол-
нив его копией лучей. Для изменения 
копии применить инструмент  
(поворот, масштабирование). Совме-
стить центры копии и исходного изоб-
ражения (Modify → Align → Hori-
zontal Center + Vertical Center):

4.  Создать новый слой «диск» с 
изображением диска солнца:

5.  В кадре 2 слоя «диск» создать 
простой кадр:

6.  Сохранить изменения в файле.
7.  Протестировать анимацию.
8.  Опубликовать фильм.
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1.  Для чего предназначена шкала времени?
2.  Какие кадры называются ключевыми?
3.  Как создается дубль ключевого кадра?
4.  Какую анимацию называют покадровой?
5.  Какую комбинацию клавиш используют для тестирования анимации?

Упражнения

   Откройте файл. С помощью покадровой ани-
мации измените эмоцию робота, как показано на 
рисунке. 

Сохраните файл. Опубликуйте получившуюся  
у вас анимацию.

   Откройте файл (результат выполне-
ния задания 1 из упражнения 2 после § 7). 
Создайте покадровую анимацию из четы-
рех ключевых кадров.

                                          

Сохраните изменения в файле. Опубликуйте анимацию.

   Откройте файл (результат выполнения упражнения 1 после § 8). Создайте пока-
дровую анимацию из пяти ключевых кадров в слое «дом».

1.  В кадрах 2 и 4 измените цвет 
окон. 
2.  Добавьте простые кадры в со-
ответствующих слоях.

   Дополните анимацию, полученную 
после выполнения упражнения 3, ани-
мацией перемещения облаков.

Сохраните анимацию в файле 
upr9_4.fla. Опубликуйте анимацию.

   Добавьте к анимации, полученной после выполнения упражнения 4, анимацию 
солнца из примера 9.5.

?
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§ 10. Анимация движения 

Пример 10.1. Использование кон-
текстного меню начального кадра.

1.  Создание движения:

2.  Удаление движения:

Пример 10.2. Создание анимации 
прямолинейного движения.

1.  Поместить фоновый рисунок и 
парашютиста на разные слои.

2.  Изображение парашютиста пре-
образовать в символ (F8).

3.  Выделить в слое с фоном кадр 45 
и добавить простые кадры (F5).

4.  Выделить в слое с парашюти-
стом кадр 45 и преобразовать его в 
ключевой (F6).

5.  Изменить размеры и положение 
парашютиста в кадре 45:

6.  Создать анимацию движения 
парашютиста по прямой.

10.1. Прямолинейное движение

При работе над покадровой анимацией 
кадры, содержащие промежуточные 
фазы движения объектов, вы создавали 
сами. Создание промежуточных кадров 
можно доверить компьютеру. В этом 
случае достаточно задать состояние 
объекта анимации в начале и в конце 
движения, а все промежуточные фазы 
движения рассчитает программа Flash.

Такая анимация называется анима-
цией движения и применима только к 
символам. На слое может находиться 
один анимированный символ.

Изображения в анимации движения 
находятся в ключевых кадрах. Про-
межуточные кадры хранят ссылки на 
первый ключевой кадр, что позволяет 
сократить размер файла с анимацией.

Включить/выключить режим ани-
мации движения можно с помощью 
команд контекстного меню начального 
кадра:

  Создать анимацию движения 
(Create Motion Tween);

  Удалить движение (Remove 
Tween).

(Рассмотрите пример 10.1.)
Самая простая анимация движе-

ния — движение по прямой (при-
мер 10.2).

После выполнения команды Создать 
анимацию движения между ключе-
выми кадрами появляется сплошная 
стрелка, расположенная на лилово-
голубом фоне. Промежуточные кадры 
отражают последовательность фаз 
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движения (пример 10.3). При создании 
анимации движения важно, чтобы:

1. Начальная и конечная фазы ани-
мации были получены из точных ко-
пий одного и того же объекта.

2. В начальном и в конечном клю-
чевых кадрах находились только един-
ственные объекты.

10.2. Движение по траектории

Для создания анимации движения 
по заданной траектории необходим спе-
циальный направляющий слой.

Направляющий слой размещается 
над слоем с анимируемым объектом. 
Для добавления направляющего слоя 
нужно:

1.  Выделить слой с анимируемым 
объектом.

2.  Нажать кнопку Добавить движе-
ние (Add Motion Guide):

На направляющем слое изображает-
ся траектория, по которой будет пере-
мещаться анимируемый объект. При 
просмотре фильма линия траектории 
не отображается. В слое с анимируе-
мым объектом задается анимация дви-
жения, как в случае прямолинейного 
движения (пример 10.4).

Для привязки объекта к траектории 
необходимо: 

1.  Включить параметр Защелка 
(Snap) на Панели инструментов. 

Пример 10.3.

 
Появление вместо стрелки штри-

ховой линии означает, что допущена 
ошибка и анимация не создана.
Пример 10.4. Создание анимации 

движения по траектории.
1.  Нарисовать или импортировать 

изображение.
2.  Создать направляющий слой и 

изобразить на нем траекторию.

3.  В кадр 40 слоя с изображени-
ем вставить копию ключевого кадра 
(F6), а в слой с траекторией добавить 
простые кадры (F5).

4.  Убедиться, что на Панели ин-
струментов активен параметр За-

щелка: .

5.  Переместить изображение в 
ключевых кадрах в положение, ког-
да точки трансформации совпадают с 
концами линии траектории.

                   
6.  В слое с изображением вклю-

чить режим анимации движения.
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2.  Совместить точку трансформации 
объекта (кружок в центре) с началом 
линии траектории (в первом кадре) и 
концом (в конечном кадре). 

Если объект не привязать к траек-
тории, то он будет двигаться прямоли-
нейно.

1.  К каким объектам можно применить анимацию   движения?
2.  Как создать анимацию движения?
3.  Как удалить анимацию движения?
4.  Для чего предназначен направляющий слой? 
5.  Как создается направляющий слой?
6.  Как связать траекторию с объектом движения?

Упражнения

   Откройте файл. Выполните пример 10.2. Сохраните изменения в файле upr10_1.fla.
Опубликуйте анимацию.

   Внесите изменения в файл upr9_4.fla (результат выполнения упражнения 4 по-
сле § 9).

1.  В слое «облака» замените покадровую анимацию на анимацию дви-
жения.
2.  Создайте анимацию прямолинейного движения автомобиля слева на-
право.
3.  Добавьте второй экземпляр автомобиля и создайте прямолинейную 
анимацию движения автомобиля справа налево.

              

Сохраните созданную анимацию в файле upr10_2.fla. Опубликуйте анимацию.

?

При создании анимации движе-
ния нескольких объектов для каж-
дого слоя с объектами создается свой 
слой направляющих. Также можно 
привязать несколько слоев к одному 
слою направляющих, чтобы несколь-
ко объектов двигались по одной и 
той же траектории.
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   Откройте файл. Создайте анимацию движения звездочки по кругу, выполняя дан-
ные ниже рекомендации.

1. С помощью инструмента  перенесите точку трансформации (центр 
будущего вращения) на некоторое расстояние.

2. В кадр 30 вставьте копию ключевого кадра.
3. Перейдите на первый кадр и откройте Панель свойств. В списке 
Определение (Tween) выберите Движение (Motion). В списке Поворот 
(Rotate) выберите принудительное вращение по (CW) или против (CCW) 
часовой стрелки.

4. Запустите анимацию на просмотр. Сохраните изменения в файле. 
Опубликуйте анимацию.

   Дополните анимацию из упражнения 3 анимацией движения ракеты. 
Сохраните изменения в файле upr10_4.fla. Опубликуйте анимацию.
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   Создайте анимацию движения по траектории. Выполните импорт изображений 
из файлов.

Фоновое изображение
Анимируемое 
изображение

Траектория движения

§ 11. Анимация формы

Анимация формы — плавное изме-
нение объекта анимации. 

При создании анимации формы объ-
ектом является не экземпляр, как при 
анимации движения, а обычное вектор-
ное изображение. Количество прими-
тивов в изображении может быть раз-
личным в начале и в конце анимации. 

В процессе анимации формы изобра-
жение может разделиться на несколь-
ко независимых фрагментов, каждый 
из которых будет постепенно трансфор-
мироваться. Или, наоборот, несколько 
независимых изображений при анима-
ции, постепенно меняя облик (разме-
ры, цвет, форму), могут стать частями 
единого изображения. Поэтому анима-
ция формы лучше всего подходит для 
простых изображений без обводки. 

В рамках анимации формы мож-
но также изменять положение и цвет 
объектов (пример 11.1). Перемещение 

Пример 11.1. Создание анимации 
формы.

1.  В первом кадре нарисовать ква-
драт:

2.  Добавить пустой ключевой кадр 
в кадре 30 (F7)

и нарисовать в нем круг:

3.  Создать анимацию формы:
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объектов при анимации формы всегда 
прямолинейно. Для создания анима-
ции формы требуется:

1.  Выбрать начальный ключевой 
кадр (или любой кадр между двумя 
ключевыми).

2.  На Панели свойств выбрать Фор-
ма (Shape): 

Между ключевыми кадрами после 
создания анимации формы должна 
появиться сплошная стрелка на сала-
товом фоне. Промежуточные кадры 
будут отражать последовательность 
фаз изменения формы (пример 11.2). 
При задании отрицательных значений 
в поле параметра Замедление (Ease) 
анимация будет идти ускоренно, а при 
вводе положительных значений этого 
параметра — замедленно.

Вам уже известно, что импортиро-
ванные растровые изображения пред-
ставляют собой символы. Их можно 
использовать при создании анимации 
формы, предварительно преобразовав в 
обычную графику (пример 11.3). 

При анимации объектов с градиент-
ной заливкой у исходного и конечного 
объекта должен быть один и тот же тип 
градиентной заливки. Flash не умеет 
преобразовывать линейный градиент в 
радиальный и наоборот.

При применении анимации формы 
к очень сложному объекту можно до-
биться лучшего результата, если раз-
бить одну анимацию на несколько и 
самостоятельно нарисовать промежу-
точные контуры.

Пример 11.2. Отображение проме-
жуточных фаз.

Переход одной формы в другую не 
всегда предсказуем. Если исходный 
и конечный объекты содержат не-
сколько фигур, то трудно предполо-
жить, как будет происходить транс-
формация.

Пример 11.3. Использование рас-
тровых изображений.

1.  Импортировать изображение на 
монтажный стол.

2.  Преобразовать символ в обыч-
ную графику.

3.  В кадрах 15 и 30 добавить ко-
пии ключевых кадров. Изменить в 
кадре 15 изображение:

4.  Создать анимацию формы.
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1.  К каким объектам можно применить анимацию формы?
2.  Какие свойства объектов могут изменяться при анимации формы?
3.  Как создать анимацию формы?
4.  Каким образом можно использовать импортированные изображения при соз-
дании анимации формы?

Упражнения

   Создайте анимацию формы «Сердце на ладони». Изображение для фона импор-
тируйте.

Номер кадра Изображение

1

10

Сохраните анимацию в файле upr11_1.fla. Опубликуйте анимацию.

   Откройте файл. Создайте анимацию формы «Мерцающая звезда».

1.  В кадре 1 преобразуйте изображение звезды в обычную графику.
2.  В кадр 15 вставьте ключевой кадр.
3.  Измените размеры звезды, удерживая клавишу Alt.
4.  Создайте анимацию формы.
5.  Сохраните изменения в файле upr11_2.fla и выполните публикацию.

   Создайте анимацию формы «Превращение».

1.  Нарисуйте в кадре 1 круг с градиентной заливкой.
2.  Перейдите в кадр 12 и преобразуйте его в пустой клю-
чевой кадр.
3.  Импортируйте в кадр 12 растровое изображение арбуза. 
Преобразуйте изображение арбуза в векторное и удалите 
фон (см. пункт 8.3, с. 40—41). Приведите в соответствие 
размер и место расположения центра круга и арбуза.
4.  Кадр 30 преобразуйте в простой кадр.
5.  Между ключевыми кадрами создайте анимацию формы.
6.  Сохраните результат и выполните публикацию.

?
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   Дополните результаты выполнения упражнений 1 и 2 анимацией формы так, что-
бы получились указанные сюжеты.

1.  «Разбитое сердце» — сердце падает и разбивается.
2.  «Звездное небо» — несколько мерцающих звезд, период и интенсив-
ность мерцания у каждой свои.

§ 12. Анимация текста

Пример 12.1. Расширяемое тексто-
вое поле.

Пример 12.2. Текстовое поле 
фиксированной ширины.

Пример 12.3. Текстовый блок.

Пример 12.4. Изменение прозрач-
ности текста.

R:
G:

B:

0

0

153

50% #000099Alpha:

Пример 12.5. Трансформация тек-
ста.

В любой фильм в редакторе Flash 
может быть добавлен текст. Для добав-
ления текста в фильм используется ин-

струмент  Текст (Text Tool). 
Место, где будет вводиться текст, 

определяется щелчком мыши. Появля-
ется выделяющая рамка — текстовое 
поле. В правом верхнем углу рамки 
имеется маркер, вид которого опреде-
ляет тип текстового поля:

  круглый маркер соответствует 
расширяемому текстовому полю (при-
мер 12.1). Это однострочное текстовое 
поле, ширина которого автоматически 
увеличивается при вводе текста;

  прямоугольный маркер соответ-
ствует текстовому полю фиксирован-
ной ширины (пример 12.2). Если оче-
редной символ не вмещается на теку-
щей строке, в таком поле выполняется 
автоматический перенос на следующую 
строку. Ширину поля можно изменить, 
перетащив маркер.

После завершения ввода образуется 
текстовый блок с голубой рамкой (при-
мер 12.3).

На Панели свойств для текста мо-
гут быть установлены: размер, шрифт, 
стиль, интервал, цвет и способ вырав-
нивания. Можно изменять прозрач-
ность цвета текста (пример 12.4).
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Текстовые блоки так же, как и изо-
бражения, можно трансформировать: 
поворачивать, масштабировать, накло-
нять (пример 12.5). При этом сохраня-
ется возможность редактирования сим-
волов текста.

Перед применением операции ис-
кажения или изгиба ко всему тексту 
(пример 12.6) текстовый блок необ-
ходимо преобразовать в графический 
объект. То же самое  выполняется для 
трансформации отдельных символов. 
Возможны два варианта применения 
команды Разбить (Break Apart):

1.  Однократное применение коман-
ды. Происходит разделение текста на 
символы с сохранением свойств каж-
дого из них как отдельного фрагмента 
текста. Символы текста заключаются в 
отдельные рамки. К каждому символу 
могут быть применены любые опера-
ции, допустимые для текстового блока 
(пример 12.7). 

2.  Команда применяется дважды. 
Символы текста преобразуются в гра-
фические объекты и выделяются как 
графические объекты. В этом случае к 
каждому символу текста можно приме-
нять градиентную заливку, искажение 
и изгиб (пример 12.8). 

После применения команды Разбить 
текст уже нельзя редактировать как 
единый объект.

К текстовым блокам примени-
ма только анимация движения (при-
мер 12.9).

Анимацию формы к тексту можно при-
менять только после преобразования 

Пример 12.6. Трансформация графи-
ческого объекта, содержащего текст.

1.  Искажение.

2.  Изгиб.

Пример 12.7. Изменение свойств 
каждого символа и применение опе-
раций трансформации.

aq
Пример 12.8. Градиентная залив-

ка и изгиб символов.

Пример 12.9. Движение текста с 
вращением.
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символов текста в графику (при-
мер 12.10). 

Чтобы символы текста анимирова-
лись по отдельности, необходимо:

1.  Преобразовать текст в графику.
2.  Выполнить команду контекст-

ного меню Распределить по слоям 
(Distribute to Layers). В результате 
каждая буква, оставаясь в первом ка-
дре, окажется в своем слое. Слои авто-
матически получат соответствующие 
имена.

Если несколько идущих подряд 
букв должны вести себя одинаково, их 
можно преобразовать в один графиче-
ский объект.

Пример 12.10. Применение анима-
ции формы к тексту.

1.  В стартовый кадр анимации им-
портировать изображение и преобра-
зовать его в графику (Ctrl + B).

2.  Через несколько кадров вста-
вить пустой ключевой кадр (финиш-
ный кадр анимации).

3.  В финишный кадр анимации 
добавить текст и преобразовать его в 
графику (Ctrl + B дважды).

4.  Создать анимацию формы.

1.  Какие виды трансформации применимы к текстовому блоку?
2.  Для чего текст преобразуют в графический объект?
3.  В каком случае с  охраняется возможность редактирования текста?
4.  Какой вид анимации применим к текстовым блокам?
5.  Когда можно применять анимацию к отдельным символам текста?

Упражнения

  Выполните примеры 12.5—12.10. Сохраните результаты работы.

   Создайте анимацию по описанию.

1.  Установите размеры документа 700 × 200 пикселей.
2.  Создайте два слоя — «герб» и «город».
3.  В первый кадр слоя «герб» импортируйте изображение герба вашего 
города (районного или областного центра). При необходимости измените 
размеры изображения, сохраняя пропорции.
4.  В первом кадре слоя «город» создайте текстовый блок с названием го-
рода. Установите шрифт, размер и цвет текста в соответствии с образцом.

5.  Кадр 19 слоя «город» преобразуйте в ключевой.

?
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6. В стартовом кадре слоя «город» измените размер и место положения 
текстового блока.

7. В кадры 35 двух слоев добавьте простые кадры.
8. В слое «город» создайте анимацию движения.
9. Сохраните результат и выполните публикацию.

   Откройте файл upr11_3.fla (результат выполнения упражнения 3 после § 11). 
Добавьте в фильм анимацию текста.

1. Создайте текстовый блок и напишите слово «АРБУЗ» под изображе-
нием круга в первом кадре.

2. Разбейте текст на отдельные буквы и распределите их по слоям.

           

3. В слое «А» преобразуйте выделенную букву в графику. 
Установите в качестве цвета буквы один из оттенков зеле-
ного и придайте букве необычную форму. 
4. Преобразуйте букву в символ для создания анимации 
движения.
5. Создайте конечную фазу будущей анимации. На неко-
тором удалении по шкале времени вставьте копию первого 
кадра: .

6. Выделите первый кадр в слое «А». Измените старто-
вые значения анимации. Для этого: вынесите изображе-
ние буквы за пределы монтажного стола; измените про-
порции буквы и перенесите точку трансформации (центр 
будущего вращения).
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7. Создайте анимацию движения. Буква, посте-
пенно изменяя свои размеры и пропорции, долж-
на вылетать из-за пределов монтажного стола и, 
совершив оборот, занять свое место. 

8. Следуя действиям, описанным в п. 3—7, создайте анимацию движе-
ния всех букв. Изменяя место расположения стартовых кадров на шка-
ле времени, добейтесь эффекта появления букв по очереди. Буквы могут 
двигаться по разным круговым или ломаным траекториям, совершать 
повороты, изменять свои размеры и пропорции. Время движения и ко-
личество поворотов букв тоже может быть разным.

Сохраните изменения в файле upr12_2.fla и выполните публикацию.
   Создайте анимацию «Вода».
1.  Установите размеры документа 400 × 200 пикселей.
2.  В первом кадре в центре монтажного стола создайте тек-
стовый блок, как показано на рисунке. Установите шрифт, 
размер и цвет текста в соответствии с образцом.
3.  Разбейте текст на отдельные буквы и распределите их по слоям.
4.  В кадр 5 всех четырех слоев добавьте ключевой кадр. Преобразуйте в 
этом кадре каждую букву в графический объект.
5.  В кадр 20 слоев «В», «О» и «Д» вставьте пустой ключевой кадр.
6.  Добавьте в каждый слой в кадре 20 текст в соответствии: «В» — «H», 
«О» — «2» и «Д» — «О». Уменьшите размер символа «2». Буквы в кад-
рах 5 и 20 должны иметь приблизительно одинаковое расположение.
7.  Кадр 20 слоя «А» сделайте ключевым. Установите прозрачность цвета 

.
8.  Преобразуйте в кадре 20 каждый символ в графический объект.
9.  Создайте анимацию формы (кадр 5 — стартовый, кадр 20 — финишный).
10.  Создайте слой «вода» в конце списка слоев. В кадр 1 слоя импорти-
руйте изображение фона.
11.  Во всех слоях кадра 35 вставьте простой кадр:

12.  Сохраните результат и выполните публикацию.
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